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Q.1 Select the most appropriate ANTONYM of the word highlighted in bold in the given
sentence.

The Principal’s actions were deemed appropriate given the sensitivity of the issue.
Ans A. Considered

B. Judged

C. Disregarded

D. Regarded

Question Type : MCQ
Question ID : 630680805417
Option 1 ID : 6306803155354
Option 2 ID : 6306803155353
Option 3 ID : 6306803155356
Option 4 ID : 6306803155355

Status : Answered
Chosen Option : C

Marks : 1

Q.2 Select the option that expresses the given sentence in reported speech.

"I finished my homework," he said.
Ans A. He said that he finishes his homework.

B. He said that he had finished his homework.

C. He said that he has finished his homework.

D. He said that he finished his homework.

Question Type : MCQ
Question ID : 630680528638
Option 1 ID : 6306802066563
Option 2 ID : 6306802066562
Option 3 ID : 6306802066561
Option 4 ID : 6306802066560

Status : Answered
Chosen Option : C

Marks : -0.25

Tentative Score
Participant ID
Participant Name
Test Center Name
Test Date 18/10/2024
Test Time 2:00 PM - 5:00 PM
Subject SI Excise Mains Examination
Marks Obtained

Section : General English

10/28/24, 8:16 PM cdn.digialm.com//per/g01/pub/852/touchstone/AssessmentQPHTMLMode1//OSSC241/OSSC241S4D1272/17297515138905997/…

https://cdn.digialm.com//per/g01/pub/852/touchstone/AssessmentQPHTMLMode1//OSSC241/OSSC241S4D1272/17297515138905997/2304389022… 1/75

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Q.3 Select the most appropriate option to fill in the blank.

The garden featured an elegant __________ pond, with its curved shape reflecting the
vibrant colours of the surrounding flowers.

Ans A. analytical

B. celestial

C. critical

D. elliptical

Question Type : MCQ
Question ID : 6306801047083
Option 1 ID : 6306804110449
Option 2 ID : 6306804110446
Option 3 ID : 6306804110448
Option 4 ID : 6306804110447

Status : Answered
Chosen Option : A

Marks : -0.25

Q.4 Select the INCORRECTLY spelt word.
Ans A. Environment

B. Catastrophe

C. Beneficiary

D. Deteriorete

Question Type : MCQ
Question ID : 630680721673
Option 1 ID : 6306802828013
Option 2 ID : 6306802828011
Option 3 ID : 6306802828010
Option 4 ID : 6306802828012

Status : Answered
Chosen Option : B

Marks : -0.25

Q.5 Select the most appropriate ANTONYM of the underlined word.

They paused the movie.
Ans A. made

B. halted

C. watched

D. continued

Question Type : MCQ
Question ID : 630680685667
Option 1 ID : 6306802685211
Option 2 ID : 6306802685209
Option 3 ID : 6306802685210
Option 4 ID : 6306802685208

Status : Answered
Chosen Option : D

Marks : 1
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Q.6 Select the most appropriate option to substitute the underlined segment in the given
sentence.

The scientist's conclusions were based on qualified certainty, having meticulously
verified every detail of the experiment.

Ans A. based on resolute certainty

B. based on certain certainty

C. based on valid certainty

D. based on absolute certainty

Question Type : MCQ
Question ID : 6306801057262
Option 1 ID : 6306804151466
Option 2 ID : 6306804151463
Option 3 ID : 6306804151464
Option 4 ID : 6306804151465

Status : Answered
Chosen Option : C

Marks : -0.25

Q.7 Select the most appropriate idiom that can substitute the underlined segment in the
given sentence. If there is no need to substitute it, select ‘No substitution required’.
The deal could not be signed as the company had too many political axes to use.

Ans A. axes to mind

B. axes to grind

C. axes to climb

D. No substitution required

Question Type : MCQ
Question ID : 630680790176
Option 1 ID : 6306803096484
Option 2 ID : 6306803096485
Option 3 ID : 6306803096486
Option 4 ID : 6306803096487

Status : Answered
Chosen Option : C

Marks : -0.25

Q.8 Select the most appropriate meaning of the given proverb.

Necessity is the mother of invention.
Ans A. Only mothers are creative.

B. Inventions happen by accident.

C. Need and hardship drive creativity and problem-solving.

D. Patience is more important than need.

Question Type : MCQ
Question ID : 6306801045965
Option 1 ID : 6306804105946
Option 2 ID : 6306804105944
Option 3 ID : 6306804105945
Option 4 ID : 6306804105947

Status : Answered
Chosen Option : C

Marks : 1
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Q.9 Select the most appropriate proverb that refers to the underlined segment in the given
sentence.

Being unemployed for almost a year, I took up an underpaid job as I was in no position
to choose the salary to work on.

Ans A. Beggars can't be choosers

B. A watched pot never boils

C. Beauty is in the eye of the beholder

D. Better late than never

Question Type : MCQ
Question ID : 630680764860
Option 1 ID : 6306802997952
Option 2 ID : 6306802997951
Option 3 ID : 6306802997954
Option 4 ID : 6306802997953

Status : Answered
Chosen Option : D

Marks : -0.25

Q.10 Select the most appropriate ANTONYM of the given word.

reflect
Ans A. Mimic

B. Distort

C. Absorb

D. Project

Question Type : MCQ
Question ID : 630680753618
Option 1 ID : 6306802953665
Option 2 ID : 6306802953668
Option 3 ID : 6306802953666
Option 4 ID : 6306802953667

Status : Answered
Chosen Option : C

Marks : 1
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Q.11 Select the most appropriate option to fill in the blank. If no article is needed, select ‘No
article required’.

Saswath went to _______ hospital to visit his close friend who was recovering from
knee replacement surgery.

Ans A. a

B. an

C. the

D. No article required

Question Type : MCQ
Question ID : 6306801042646
Option 1 ID : 6306804092777
Option 2 ID : 6306804092778
Option 3 ID : 6306804092779
Option 4 ID : 6306804092780

Status : Answered
Chosen Option : C

Marks : 1

Q.12 Select the most appropriate option to substitute the underlined word segment in the
given sentence.

Last night, we watched an interested movie that kept us on the edge of our seats until
the very end.

Ans A. watched an interspersed movie

B. watched an interspersing movie

C. watched an interesting movie

D. watched an interest movie

Question Type : MCQ
Question ID : 6306801057197
Option 1 ID : 6306804151199
Option 2 ID : 6306804151200
Option 3 ID : 6306804151197
Option 4 ID : 6306804151198

Status : Answered
Chosen Option : C

Marks : 1
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Q.13 Select the option that expresses the given sentence in direct speech.

He said he'd worked as a waiter before becoming a chef.
Ans A. He said, I have been working as a waiter before becoming a chef.

B. He said, I am working as a waiter before becoming a chef.

C. He said, I worked as a waiter before becoming a chef.

D. He said, I had been working as a waiter before becoming a chef.

Question Type : MCQ
Question ID : 630680805978
Option 1 ID : 6306803157579
Option 2 ID : 6306803157578
Option 3 ID : 6306803157576
Option 4 ID : 6306803157577

Status : Answered
Chosen Option : C

Marks : 1

Q.14 Select the most appropriate meaning of the given proverb

Fortune favours the bold.
Ans A. Fortune comes to those who wait.

B. Boldness is not necessary for success.

C. Taking risks and being brave often leads to success.

D. Only bold people are lucky.

Question Type : MCQ
Question ID : 6306801046010
Option 1 ID : 6306804106126
Option 2 ID : 6306804106127
Option 3 ID : 6306804106124
Option 4 ID : 6306804106125

Status : Answered
Chosen Option : C

Marks : 1

Q.15 Select the most appropriate option to substitute the underlined word segment in the
given sentence.

The city has many popular touristical attractions, which draw visitors from around the
world to experience its rich history, vibrant culture and stunning landscapes.

Ans A. popular touring attractions

B. popular tourism attractions

C. popular tourist attractions

D. popular touristic attractions

Question Type : MCQ
Question ID : 6306801057221
Option 1 ID : 6306804151298
Option 2 ID : 6306804151296
Option 3 ID : 6306804151295
Option 4 ID : 6306804151297

Status : Answered
Chosen Option : C

Marks : 1
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Q.16 Select the most appropriate homonym to fill in the blank.

Please _______ this envelope to the address provided.
Ans A. mile

B. mail

C. meal

D. male

Question Type : MCQ
Question ID : 6306801045394
Option 1 ID : 6306804103702
Option 2 ID : 6306804103700
Option 3 ID : 6306804103703
Option 4 ID : 6306804103701

Status : Answered
Chosen Option : B

Marks : 1

Q.17 Fill in the blank with an appropriate homonym from the given options.
The country is taking strict measures to control the influx of illegal _____________.

Ans A. emmigrants

B. emigrants 

C. migrants

D. immigrants 

Question Type : MCQ
Question ID : 63068084469
Option 1 ID : 630680327431
Option 2 ID : 630680327428
Option 3 ID : 630680327430
Option 4 ID : 630680327429

Status : Answered
Chosen Option : D

Marks : 1

Q.18 Select the most appropriate ANTONYM of the highlighted word.
The railways are common carriers of certain classes of brittle goods.

Ans A. Sturdy

B. Vinegary

C. Friendly

D. Crackly

Question Type : MCQ
Question ID : 6306801159908
Option 1 ID : 6306804559112
Option 2 ID : 6306804559114
Option 3 ID : 6306804559111
Option 4 ID : 6306804559113

Status : Answered
Chosen Option : C

Marks : -0.25
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Q.19 Select the most appropriate meaning of the given proverb.
The pen is mightier than the sword.

Ans A. The pen is made from a superior substance.

B. The pen can be used to fight battles.

C. Writing is more effective than military power or violence.

D. The pen is heavier than the sword.

Question Type : MCQ
Question ID : 630680791399
Option 1 ID : 6306803101310
Option 2 ID : 6306803101311
Option 3 ID : 6306803101308
Option 4 ID : 6306803101309

Status : Answered
Chosen Option : C

Marks : 1

Q.20 Select the most appropriate ANTONYM of the given word.
Despicable

Ans A. Wretched

B. Disgraceful

C. Admirable

D. Shameful

Question Type : MCQ
Question ID : 630680766790
Option 1 ID : 6306803005452
Option 2 ID : 6306803005451
Option 3 ID : 6306803005450
Option 4 ID : 6306803005449

Status : Answered
Chosen Option : C

Marks : 1

Q.21 Select the most appropriate option to fill in the blanks.
_____ index with details is ____ important aspect of the dissertation.

Ans A. A, a 

B. A, an 

C.  An, a

D. An, an 

Question Type : MCQ
Question ID : 63068080501
Option 1 ID : 630680312030
Option 2 ID : 630680312031
Option 3 ID : 630680312032
Option 4 ID : 630680312029

Status : Answered
Chosen Option : C

Marks : -0.25
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Q.22 Select the correct spelling of the incorrectly spelt word in the given sentence.
The phenomenon of bioluminesence is observed in many marine organisms.

Ans A. Bioluminesense

B. Bioluminescence

C. Bioluminiscence

D. Biolouminescence

Question Type : MCQ
Question ID : 630680721678
Option 1 ID : 6306802828032
Option 2 ID : 6306802828030
Option 3 ID : 6306802828031
Option 4 ID : 6306802828033

Status : Answered
Chosen Option : C

Marks : -0.25

Q.23 Select the most appropriate option to fill in the blank.

The ancient manuscript contained ____________ symbols and rituals,
shrouded in mystery, that only a few specialised scholars could decipher.

Ans A. arcane

B. adamantine

C. inane

D. mundane

Question Type : MCQ
Question ID : 6306801056011
Option 1 ID : 6306804146554
Option 2 ID : 6306804146557
Option 3 ID : 6306804146556
Option 4 ID : 6306804146555

Status : Answered
Chosen Option : A

Marks : 1

Q.24 Select the option that rectifies the underlined spelling error.

The lack of rainfall during the dry season execerbates the already challenging
conditions for farmers in the region.

Ans A. execerbets

B. exacerbates

C. exacarbets

D. execerbeats

Question Type : MCQ
Question ID : 630680749080
Option 1 ID : 6306802935854
Option 2 ID : 6306802935852
Option 3 ID : 6306802935853
Option 4 ID : 6306802935855

Status : Answered
Chosen Option : D

Marks : -0.25
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Q.25 The following sentence has been split into four segments. Identify the segment that
contains a grammatical error.

He coughed loud / to attract / the attention / of the audience.
Ans A. of the audience

B. the attention

C. He coughed loud

D. to attract

Question Type : MCQ
Question ID : 630680437895
Option 1 ID : 6306801709409
Option 2 ID : 6306801709408
Option 3 ID : 6306801709406
Option 4 ID : 6306801709407

Status : Answered
Chosen Option : C

Marks : 1

Comprehension:
Read the given passage and answer the questions that follow.
“About what time do you think I’m going to die?“ Schatz asked.
“What?”
“About how long will it be before I die?”
“You aren’t going to die. What’s the matter with you?”
“Oh, yes. I am. I heard him say a hundred and two.”
“People don’t die with a fever of one hundred and two. That’s a silly way to talk.”
“I know they do. At school in France the boys told me you can’t live with forty-four degrees.
I’ve got a hundred and two.”
He had been waiting to die all day, ever since nine in the morning.
“You poor Schatz,” I said. “Poor old Schatz. It’s like miles and kilometers. You aren’t going to
die. That’s a different thermometer. On that thermometer thirty-seven is normal. On this kind
it’s ninety-eight.”
“Are you sure?”
“Absolutely,” I said. “It’s like miles and kilometers. You know, like how many kilometers we
make when we do seventy in the car?”
“Oh,” he said.

SubQuestion No : 26
Q.26 From the given options, identify the meaning of the word gaze.
Ans A. Stare

B. Gauge

C. Gauze

D. Stair

Question Type : MCQ
Question ID : 630680650724
Option 1 ID : 6306802547872
Option 2 ID : 6306802547870
Option 3 ID : 6306802547871
Option 4 ID : 6306802547873

Status : Answered
Chosen Option : D

Marks : -0.25
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Comprehension:
Read the given passage and answer the questions that follow.
“About what time do you think I’m going to die?“ Schatz asked.
“What?”
“About how long will it be before I die?”
“You aren’t going to die. What’s the matter with you?”
“Oh, yes. I am. I heard him say a hundred and two.”
“People don’t die with a fever of one hundred and two. That’s a silly way to talk.”
“I know they do. At school in France the boys told me you can’t live with forty-four degrees.
I’ve got a hundred and two.”
He had been waiting to die all day, ever since nine in the morning.
“You poor Schatz,” I said. “Poor old Schatz. It’s like miles and kilometers. You aren’t going to
die. That’s a different thermometer. On that thermometer thirty-seven is normal. On this kind
it’s ninety-eight.”
“Are you sure?”
“Absolutely,” I said. “It’s like miles and kilometers. You know, like how many kilometers we
make when we do seventy in the car?”
“Oh,” he said.

SubQuestion No : 27
Q.27 What is the main theme of the passage? Select your answer from the options given.
Ans A. The little boy Schatz remembers his school.

B. Schatz has heard the doctor say that he has fever and is going to die.

C. Waiting to go for long drives in a car.

D. Miscommunication and misunderstanding the reading of the thermometer as well as
a fatalistic heroism shown by the boy.

Question Type : MCQ
Question ID : 630680650721
Option 1 ID : 6306802547858
Option 2 ID : 6306802547859
Option 3 ID : 6306802547861
Option 4 ID : 6306802547860

Status : Answered
Chosen Option : B

Marks : -0.25
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Comprehension:
Read the given passage and answer the questions that follow.
“About what time do you think I’m going to die?“ Schatz asked.
“What?”
“About how long will it be before I die?”
“You aren’t going to die. What’s the matter with you?”
“Oh, yes. I am. I heard him say a hundred and two.”
“People don’t die with a fever of one hundred and two. That’s a silly way to talk.”
“I know they do. At school in France the boys told me you can’t live with forty-four degrees.
I’ve got a hundred and two.”
He had been waiting to die all day, ever since nine in the morning.
“You poor Schatz,” I said. “Poor old Schatz. It’s like miles and kilometers. You aren’t going to
die. That’s a different thermometer. On that thermometer thirty-seven is normal. On this kind
it’s ninety-eight.”
“Are you sure?”
“Absolutely,” I said. “It’s like miles and kilometers. You know, like how many kilometers we
make when we do seventy in the car?”
“Oh,” he said.

SubQuestion No : 28
Q.28 What was Schatz waiting for the whole day? Select your answer from the given

options.
Ans A. To die

B. To have a hearty meal

C. To take a car ride

D. To get back to his school

Question Type : MCQ
Question ID : 630680650722
Option 1 ID : 6306802547864
Option 2 ID : 6306802547863
Option 3 ID : 6306802547865
Option 4 ID : 6306802547862

Status : Answered
Chosen Option : A

Marks : 1
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Comprehension:
Read the given passage and answer the questions that follow.
“About what time do you think I’m going to die?“ Schatz asked.
“What?”
“About how long will it be before I die?”
“You aren’t going to die. What’s the matter with you?”
“Oh, yes. I am. I heard him say a hundred and two.”
“People don’t die with a fever of one hundred and two. That’s a silly way to talk.”
“I know they do. At school in France the boys told me you can’t live with forty-four degrees.
I’ve got a hundred and two.”
He had been waiting to die all day, ever since nine in the morning.
“You poor Schatz,” I said. “Poor old Schatz. It’s like miles and kilometers. You aren’t going to
die. That’s a different thermometer. On that thermometer thirty-seven is normal. On this kind
it’s ninety-eight.”
“Are you sure?”
“Absolutely,” I said. “It’s like miles and kilometers. You know, like how many kilometers we
make when we do seventy in the car?”
“Oh,” he said.

SubQuestion No : 29
Q.29 Identify the most suitable title for the passage. Select your answer from the given

options.
Ans A. Miles and Kilometers

B. A School in France

C. Seventy in the Car

D. Innocence of a Child

Question Type : MCQ
Question ID : 630680650720
Option 1 ID : 6306802547857
Option 2 ID : 6306802547856
Option 3 ID : 6306802547855
Option 4 ID : 6306802547854

Status : Answered
Chosen Option : D

Marks : 1
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Comprehension:
Read the given passage and answer the questions that follow.
“About what time do you think I’m going to die?“ Schatz asked.
“What?”
“About how long will it be before I die?”
“You aren’t going to die. What’s the matter with you?”
“Oh, yes. I am. I heard him say a hundred and two.”
“People don’t die with a fever of one hundred and two. That’s a silly way to talk.”
“I know they do. At school in France the boys told me you can’t live with forty-four degrees.
I’ve got a hundred and two.”
He had been waiting to die all day, ever since nine in the morning.
“You poor Schatz,” I said. “Poor old Schatz. It’s like miles and kilometers. You aren’t going to
die. That’s a different thermometer. On that thermometer thirty-seven is normal. On this kind
it’s ninety-eight.”
“Are you sure?”
“Absolutely,” I said. “It’s like miles and kilometers. You know, like how many kilometers we
make when we do seventy in the car?”
“Oh,” he said.

SubQuestion No : 30
Q.30 How is the given passage connected to real life? Select your answer from the options

provided.
Ans A. Stay in fear and anxiety and wait to die if you have slight fever.

B. We should not jump to conclusions. It is better to verify what we hear and find out the
real facts.

C. We should always travel in cars.

D. Schooling must be done in France.

Question Type : MCQ
Question ID : 630680650723
Option 1 ID : 6306802547869
Option 2 ID : 6306802547868
Option 3 ID : 6306802547867
Option 4 ID : 6306802547866

Status : Answered
Chosen Option : B

Marks : 1
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Comprehension:
Read the given passage and answer the questions that follow.

Have a quick think back to the last time you scrolled through social media. Maybe it was this
morning, last night or a few minutes ago. What do you recall? One thing you are bound to
remember is the continuous stream of influencers showing off their latest content. These
could be videos of influencers discussing the latest skin-care products, the trendiest places to
eat, their latest shopping haul or the PR packages they received from various brands.

Much of social media influencing is about getting consumers to buy more products. However,
there is a contrasting group of influencers who use their online presence to advocate for
changing how people buy and consume.

'Ethical influencers', as we call them, use social media to campaign for leading a more
sustainable, healthy and ethical lifestyle. Unlike other lifestyle influencers, ethical influencers
face two unique challenges that make it harder for them to build their online profiles.

First, they have to provide a closeup of their everyday life to demonstrate the new lifestyle to
their audience. This is different from other influencers who might avoid sharing their personal
life and play out a well-curated public persona that can greatly contrast their private life, which
can sometimes put them at greater risk of scrutiny.

Second, ethical influencers aim to reach out to a diverse audience, some of whom are not
necessarily interested in the new lifestyle. Because ethical influencers are fundamentally
trying to promote certain lifestyle choices and habits, they need to connect with a wide range
of people to convince them to alter their beliefs and behaviour.

SubQuestion No : 31
Q.31 Which of the following options best summarises the passage?

Ans A. It examines the rise of ethical influencers and their advocacy for sustainable living.

B. It discusses the challenges faced by ethical influencers in demonstrating their
lifestyle to a diverse audience and promoting sustainable and ethical choices.

C. It provides a comprehensive analysis of social media platforms' influence on
consumer behavior, exploring the evolution of influencer marketing and its impact on society
in general.

D. The passage highlights the unique strategies employed by lifestyle influencers to
maintain personal privacy while engaging with their audience, contrasting them with other
influencers.

Question Type : MCQ
Question ID : 630680798853
Option 1 ID : 6306803130229
Option 2 ID : 6306803130227
Option 3 ID : 6306803130226
Option 4 ID : 6306803130228

Status : Answered
Chosen Option : C

Marks : -0.25
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Comprehension:
Read the given passage and answer the questions that follow.

Have a quick think back to the last time you scrolled through social media. Maybe it was this
morning, last night or a few minutes ago. What do you recall? One thing you are bound to
remember is the continuous stream of influencers showing off their latest content. These
could be videos of influencers discussing the latest skin-care products, the trendiest places to
eat, their latest shopping haul or the PR packages they received from various brands.

Much of social media influencing is about getting consumers to buy more products. However,
there is a contrasting group of influencers who use their online presence to advocate for
changing how people buy and consume.

'Ethical influencers', as we call them, use social media to campaign for leading a more
sustainable, healthy and ethical lifestyle. Unlike other lifestyle influencers, ethical influencers
face two unique challenges that make it harder for them to build their online profiles.

First, they have to provide a closeup of their everyday life to demonstrate the new lifestyle to
their audience. This is different from other influencers who might avoid sharing their personal
life and play out a well-curated public persona that can greatly contrast their private life, which
can sometimes put them at greater risk of scrutiny.

Second, ethical influencers aim to reach out to a diverse audience, some of whom are not
necessarily interested in the new lifestyle. Because ethical influencers are fundamentally
trying to promote certain lifestyle choices and habits, they need to connect with a wide range
of people to convince them to alter their beliefs and behaviour.

SubQuestion No : 32
Q.32 What does the word 'advocate' mean in the context of the passage?

Ans A. To argue against something

B. To ignore or dismiss something

C. To criticise or condemn something

D. To promote or support something

Question Type : MCQ
Question ID : 630680798854
Option 1 ID : 6306803130230
Option 2 ID : 6306803130232
Option 3 ID : 6306803130233
Option 4 ID : 6306803130231

Status : Answered
Chosen Option : D

Marks : 1
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Comprehension:
Read the given passage and answer the questions that follow.

Have a quick think back to the last time you scrolled through social media. Maybe it was this
morning, last night or a few minutes ago. What do you recall? One thing you are bound to
remember is the continuous stream of influencers showing off their latest content. These
could be videos of influencers discussing the latest skin-care products, the trendiest places to
eat, their latest shopping haul or the PR packages they received from various brands.

Much of social media influencing is about getting consumers to buy more products. However,
there is a contrasting group of influencers who use their online presence to advocate for
changing how people buy and consume.

'Ethical influencers', as we call them, use social media to campaign for leading a more
sustainable, healthy and ethical lifestyle. Unlike other lifestyle influencers, ethical influencers
face two unique challenges that make it harder for them to build their online profiles.

First, they have to provide a closeup of their everyday life to demonstrate the new lifestyle to
their audience. This is different from other influencers who might avoid sharing their personal
life and play out a well-curated public persona that can greatly contrast their private life, which
can sometimes put them at greater risk of scrutiny.

Second, ethical influencers aim to reach out to a diverse audience, some of whom are not
necessarily interested in the new lifestyle. Because ethical influencers are fundamentally
trying to promote certain lifestyle choices and habits, they need to connect with a wide range
of people to convince them to alter their beliefs and behaviour.

SubQuestion No : 33
Q.33 Which of the following is a challenge faced by ethical influencers as mentioned in the

passage?

Ans A. They avoid sharing personal details about their lives.

B. They aim to reach out to a narrow, specific audience.

C. They primarily focus on promoting consumer products.

D. They must demonstrate their everyday life to their audience.

Question Type : MCQ
Question ID : 630680798850
Option 1 ID : 6306803130214
Option 2 ID : 6306803130217
Option 3 ID : 6306803130215
Option 4 ID : 6306803130216

Status : Answered
Chosen Option : B

Marks : -0.25
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Comprehension:
Read the given passage and answer the questions that follow.

Have a quick think back to the last time you scrolled through social media. Maybe it was this
morning, last night or a few minutes ago. What do you recall? One thing you are bound to
remember is the continuous stream of influencers showing off their latest content. These
could be videos of influencers discussing the latest skin-care products, the trendiest places to
eat, their latest shopping haul or the PR packages they received from various brands.

Much of social media influencing is about getting consumers to buy more products. However,
there is a contrasting group of influencers who use their online presence to advocate for
changing how people buy and consume.

'Ethical influencers', as we call them, use social media to campaign for leading a more
sustainable, healthy and ethical lifestyle. Unlike other lifestyle influencers, ethical influencers
face two unique challenges that make it harder for them to build their online profiles.

First, they have to provide a closeup of their everyday life to demonstrate the new lifestyle to
their audience. This is different from other influencers who might avoid sharing their personal
life and play out a well-curated public persona that can greatly contrast their private life, which
can sometimes put them at greater risk of scrutiny.

Second, ethical influencers aim to reach out to a diverse audience, some of whom are not
necessarily interested in the new lifestyle. Because ethical influencers are fundamentally
trying to promote certain lifestyle choices and habits, they need to connect with a wide range
of people to convince them to alter their beliefs and behaviour.

SubQuestion No : 34
Q.34 What distinguishes ethical influencers from other lifestyle influencers?

Ans A. They avoid promoting any products or brands.

B. They aim to connect with a diverse audience.

C. They focus solely on promoting consumer products.

D. They curate a well-defined public persona.

Question Type : MCQ
Question ID : 630680798851
Option 1 ID : 6306803130218
Option 2 ID : 6306803130220
Option 3 ID : 6306803130219
Option 4 ID : 6306803130221

Status : Answered
Chosen Option : C

Marks : -0.25
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Comprehension:
Read the given passage and answer the questions that follow.

Have a quick think back to the last time you scrolled through social media. Maybe it was this
morning, last night or a few minutes ago. What do you recall? One thing you are bound to
remember is the continuous stream of influencers showing off their latest content. These
could be videos of influencers discussing the latest skin-care products, the trendiest places to
eat, their latest shopping haul or the PR packages they received from various brands.

Much of social media influencing is about getting consumers to buy more products. However,
there is a contrasting group of influencers who use their online presence to advocate for
changing how people buy and consume.

'Ethical influencers', as we call them, use social media to campaign for leading a more
sustainable, healthy and ethical lifestyle. Unlike other lifestyle influencers, ethical influencers
face two unique challenges that make it harder for them to build their online profiles.

First, they have to provide a closeup of their everyday life to demonstrate the new lifestyle to
their audience. This is different from other influencers who might avoid sharing their personal
life and play out a well-curated public persona that can greatly contrast their private life, which
can sometimes put them at greater risk of scrutiny.

Second, ethical influencers aim to reach out to a diverse audience, some of whom are not
necessarily interested in the new lifestyle. Because ethical influencers are fundamentally
trying to promote certain lifestyle choices and habits, they need to connect with a wide range
of people to convince them to alter their beliefs and behaviour.

SubQuestion No : 35
Q.35 What can be inferred about the audience of ethical influencers?

Ans A. They are mainly interested in superficial content.

B. They may not initially be interested in the lifestyle promoted by ethical influencers.

C. They are primarily interested in personal privacy.

D. They are more likely to be influenced by consumer products.

Question Type : MCQ
Question ID : 630680798852
Option 1 ID : 6306803130225
Option 2 ID : 6306803130224
Option 3 ID : 6306803130222
Option 4 ID : 6306803130223

Status : Answered
Chosen Option : C

Marks : -0.25
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Comprehension:

SubQuestion No : 22
Q.22

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 6306801146010
Option 1 ID : 6306804504210
Option 2 ID : 6306804504207
Option 3 ID : 6306804504208
Option 4 ID : 6306804504209

Status : Answered
Chosen Option : B

Marks : 1

10/28/24, 8:16 PM cdn.digialm.com//per/g01/pub/852/touchstone/AssessmentQPHTMLMode1//OSSC241/OSSC241S4D1272/17297515138905997/…

https://cdn.digialm.com//per/g01/pub/852/touchstone/AssessmentQPHTMLMode1//OSSC241/OSSC241S4D1272/17297515138905997/230438902… 31/75

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Comprehension:

SubQuestion No : 23
Q.23

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 6306801146007
Option 1 ID : 6306804504198
Option 2 ID : 6306804504196
Option 3 ID : 6306804504197
Option 4 ID : 6306804504195

Status : Answered
Chosen Option : B

Marks : -0.25
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Comprehension:

SubQuestion No : 24
Q.24

Ans A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 6306801146011
Option 1 ID : 6306804504214
Option 2 ID : 6306804504213
Option 3 ID : 6306804504212
Option 4 ID : 6306804504211

Status : Answered
Chosen Option : A

Marks : 1
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Comprehension:

SubQuestion No : 25
Q.25

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 6306801146008
Option 1 ID : 6306804504201
Option 2 ID : 6306804504199
Option 3 ID : 6306804504202
Option 4 ID : 6306804504200

Status : Answered
Chosen Option : D

Marks : 1
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Comprehension:

SubQuestion No : 26
Q.26

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 6306801146254
Option 1 ID : 6306804505163
Option 2 ID : 6306804505165
Option 3 ID : 6306804505166
Option 4 ID : 6306804505164

Status : Answered
Chosen Option : B

Marks : -0.25

10/28/24, 8:16 PM cdn.digialm.com//per/g01/pub/852/touchstone/AssessmentQPHTMLMode1//OSSC241/OSSC241S4D1272/17297515138905997/…

https://cdn.digialm.com//per/g01/pub/852/touchstone/AssessmentQPHTMLMode1//OSSC241/OSSC241S4D1272/17297515138905997/230438902… 35/75

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Comprehension:

SubQuestion No : 27
Q.27

Ans A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 6306801146253
Option 1 ID : 6306804505161
Option 2 ID : 6306804505160
Option 3 ID : 6306804505159
Option 4 ID : 6306804505162

Status : Answered
Chosen Option : C

Marks : 1
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Comprehension:

SubQuestion No : 28
Q.28

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 6306801146252
Option 1 ID : 6306804505156
Option 2 ID : 6306804505157
Option 3 ID : 6306804505158
Option 4 ID : 6306804505155

Status : Answered
Chosen Option : B

Marks : 1
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Comprehension:

SubQuestion No : 29
Q.29

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 6306801146251
Option 1 ID : 6306804505151
Option 2 ID : 6306804505153
Option 3 ID : 6306804505152
Option 4 ID : 6306804505154

Status : Answered
Chosen Option : C

Marks : 1
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Comprehension:

SubQuestion No : 30
Q.30

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 6306801146250
Option 1 ID : 6306804505147
Option 2 ID : 6306804505150
Option 3 ID : 6306804505149
Option 4 ID : 6306804505148

Status : Answered
Chosen Option : A

Marks : 1
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Comprehension:

SubQuestion No : 31
Q.31

Ans

A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 6306801157769
Option 1 ID : 6306804550221
Option 2 ID : 6306804550219
Option 3 ID : 6306804550220
Option 4 ID : 6306804550218

Status : Answered
Chosen Option : D

Marks : 1
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Comprehension:

SubQuestion No : 32
Q.32

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 6306801157766
Option 1 ID : 6306804550206
Option 2 ID : 6306804550209
Option 3 ID : 6306804550208
Option 4 ID : 6306804550207

Status : Answered
Chosen Option : A

Marks : 1

10/28/24, 8:16 PM cdn.digialm.com//per/g01/pub/852/touchstone/AssessmentQPHTMLMode1//OSSC241/OSSC241S4D1272/17297515138905997/…

https://cdn.digialm.com//per/g01/pub/852/touchstone/AssessmentQPHTMLMode1//OSSC241/OSSC241S4D1272/17297515138905997/230438902… 41/75

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Comprehension:

SubQuestion No : 33
Q.33

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 6306801157770
Option 1 ID : 6306804550225
Option 2 ID : 6306804550224
Option 3 ID : 6306804550223
Option 4 ID : 6306804550222

Status : Answered
Chosen Option : C

Marks : 1
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Comprehension:

SubQuestion No : 34
Q.34

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 6306801157768
Option 1 ID : 6306804550214
Option 2 ID : 6306804550215
Option 3 ID : 6306804550216
Option 4 ID : 6306804550217

Status : Answered
Chosen Option : C

Marks : 1
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Comprehension:

SubQuestion No : 35
Q.35

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 6306801157767
Option 1 ID : 6306804550212
Option 2 ID : 6306804550210
Option 3 ID : 6306804550211
Option 4 ID : 6306804550213

Status : Answered
Chosen Option : A

Marks : 1

Section : General Science
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Q.1 Where did the DRDO develop the indigenous assault rifle 'UGRAM' in 2024?
Ans A. Laboratory for Electro Optics Systems

B. Armament Research and Development Establishment

C. Physical Research Laboratory

D. National Remote Sensing Centre

Question Type : MCQ
Question ID : 630680752225
Option 1 ID : 6306802948257
Option 2 ID : 6306802948255
Option 3 ID : 6306802948256
Option 4 ID : 6306802948258

Status : Answered
Chosen Option : B

Marks : 1

Q.2 The regions within a plant which are in a continuous state of cell division and growth
are made up of ___________.

Ans A. dermal tissue

B. vascular tissue

C. meristematic tissue

D. ground tissue

Question Type : MCQ
Question ID : 630680711436
Option 1 ID : 6306802787401
Option 2 ID : 6306802787403
Option 3 ID : 6306802787400
Option 4 ID : 6306802787402

Status : Answered
Chosen Option : C

Marks : 1

Q.3 Select all the statements that are possible when it is said that 'spinach is rich in iron'.

A. Spinach has a lot of iron.
B. Spinach has only iron.
C. Spinach may have other nutrients.
D. Spinach is harmful for the human body.

Ans A. A and C

B. B

C. A and B

D. D

Question Type : MCQ
Question ID : 630680565815
Option 1 ID : 6306802212200
Option 2 ID : 6306802212201
Option 3 ID : 6306802212203
Option 4 ID : 6306802212202

Status : Answered
Chosen Option : A

Marks : 1
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Q.4 Identify the correct option regarding the pH of some common substances.
Ans A. Lemon juice - pH is 4

B. Gastric juice - pH is more than 4

C. Milk of magnesia - pH is more than 9

D. Sodium hydroxide solution - pH is less than 9

Question Type : MCQ
Question ID : 630680770507
Option 1 ID : 6306803019938
Option 2 ID : 6306803019937
Option 3 ID : 6306803019939
Option 4 ID : 6306803019940

Status : Answered
Chosen Option : C

Marks : 1

Q.5 In 2024, scientists from the DRDO Young Scientists Laboratory for Quantum
Technologies (DYSL-QT), ________, and the Tata Institute of Fundamental Research
(TIFR), ____________, have completed end-to-end testing of a 6-qubit quantum
processor based on superconducting circuit technology.

Ans A. Delhi, Bengaluru

B. Chennai; Hyderabad

C. Ahmedabad; Lucknow

D. Pune; Mumbai

Question Type : MCQ
Question ID : 6306801047299
Option 1 ID : 6306804111306
Option 2 ID : 6306804111309
Option 3 ID : 6306804111308
Option 4 ID : 6306804111307

Status : Answered
Chosen Option : B

Marks : -0.25

Q.6 The ALH Dhruv Mk III UT (Utility), the Indian Army version, is designed for
_____________, Troop Transportation, Internal Cargo, Recce / Casualty Evacuation,
etc.

Ans A. Search & Rescue

B. War Time Activity

C. Industrial Activity

D. Agriculture Activity

Question Type : MCQ
Question ID : 6306801045223
Option 1 ID : 6306804103033
Option 2 ID : 6306804103032
Option 3 ID : 6306804103034
Option 4 ID : 6306804103035

Status : Answered
Chosen Option : A

Marks : 1
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Q.7 The position of a projectile is given by x = a + bt2, where a = 8.5 m, b = 2.5 m s-2 and t
is measured in seconds. The velocity at t = 0 second is ________________________.

Ans A. 5.0 m/s

B. 8.5 m/s

C. 2.5 m/s

D. 0 m/s

Question Type : MCQ
Question ID : 630680764399
Option 1 ID : 6306802996137
Option 2 ID : 6306802996135
Option 3 ID : 6306802996136
Option 4 ID : 6306802996138

Status : Answered
Chosen Option : C

Marks : -0.25

Q.8 In which of the following missiles did the DRDO successfully test the maiden
Multiple Independently Targetable Re-Entry Vehicle (MIRV) technology?

Ans A. Agni V

B. Nag

C. BrahMos

D. Astra

Question Type : MCQ
Question ID : 630680867651
Option 1 ID : 6306803398248
Option 2 ID : 6306803398249
Option 3 ID : 6306803398250
Option 4 ID : 6306803398251

Status : Answered
Chosen Option : A

Marks : 1

Q.9 Which of these have their own DNA and ribosomes?
Ans A. Mitochondria

B. Vacuoles

C. Lysosomes

D. Golgi complex

Question Type : MCQ
Question ID : 630680750787
Option 1 ID : 6306802942576
Option 2 ID : 6306802942574
Option 3 ID : 6306802942575
Option 4 ID : 6306802942577

Status : Answered
Chosen Option : A

Marks : 1
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Q.10 The ratio of hydraulic stress to the corresponding hydraulic strain of a body is called
_______.

Ans A. Young’s Modulus

B. Hooke's Modulus

C. Shear Modulus

D. Bulk Modulus

Question Type : MCQ
Question ID : 630680745796
Option 1 ID : 6306802923361
Option 2 ID : 6306802923362
Option 3 ID : 6306802923360
Option 4 ID : 6306802923359

Status : Answered
Chosen Option : D

Marks : 1

Q.11

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 630680546600
Option 1 ID : 6306802136968
Option 2 ID : 6306802136967
Option 3 ID : 6306802136969
Option 4 ID : 6306802136970

Status : Answered
Chosen Option : B

Marks : -0.25

Section : Current Events
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Q.12 Who was awarded the Player of the Tournament at ICC T20 World Cup 2024?
Ans A. Virat Kohli

B. Suryakumar Yadav

C. Rohit Sharma

D. Jasprit Bumrah

Question Type : MCQ
Question ID : 6306801050014
Option 1 ID : 6306804122406
Option 2 ID : 6306804122408
Option 3 ID : 6306804122407
Option 4 ID : 6306804122405

Status : Answered
Chosen Option : D

Marks : 1

Q.13 Which amount was allocated by the union government for Agri Fund for Start-Ups &
Rural Enterprises (AgriSURE Fund) in the July 2024 union budget?

Ans A. ₹675 crore

B. ₹980 crore

C. ₹815 crore

D. ₹750 crore

Question Type : MCQ
Question ID : 6306801050065
Option 1 ID : 6306804122609
Option 2 ID : 6306804122610
Option 3 ID : 6306804122612
Option 4 ID : 6306804122611

Status : Answered
Chosen Option : D

Marks : 1

Q.14 During which of the following events did the African heads of state unanimously agree
to a historic ban on the trade of donkey skin in 2024?

Ans A. 35th African Union Summit

B. 40th African Union Summit

C. 37th African Union Summit

D.
38th African Union Summit

Question Type : MCQ
Question ID : 6306801057059
Option 1 ID : 6306804150647
Option 2 ID : 6306804150645
Option 3 ID : 6306804150646
Option 4 ID : 6306804150648

Status : Answered
Chosen Option : B

Marks : -0.25
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Q.15 Boxer Cindy Ngamba and Taekwondo athlete Yahya Al Ghotany served as flag bearers
for one team at the Paris 2024 Olympics Opening Ceremony. Which team was it?

Ans A. Refugee Olympic Team

B. Cameroon

C. United Kingdom

D. Syria

Question Type : MCQ
Question ID : 6306801062014
Option 1 ID : 6306804170441
Option 2 ID : 6306804170443
Option 3 ID : 6306804170444
Option 4 ID : 6306804170442

Status : Answered
Chosen Option : B

Marks : -0.25

Q.16 Sanjay Kumar Jain was appointed as the Chairman and Managing Director of which
company in February 2024?

Ans A. National Thermal Power Corporation

B. Indian Railway Catering and Tourism Corporation Ltd

C. Power Grid Corporation of India Limited

D. Bharat Heavy Electricals Limited

Question Type : MCQ
Question ID : 6306801050053
Option 1 ID : 6306804122563
Option 2 ID : 6306804122561
Option 3 ID : 6306804122564
Option 4 ID : 6306804122562

Status : Answered
Chosen Option : B

Marks : 1
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Q.17

Ans A.

B. 

C. 

D. 

Question Type : MCQ
Question ID : 6306801057353
Option 1 ID : 6306804151818
Option 2 ID : 6306804151815
Option 3 ID : 6306804151817
Option 4 ID : 6306804151816

Status : Answered
Chosen Option : B

Marks : -0.25

Q.18 Who secured the Women's singles title at the 2024 Wimbledon tournament?
Ans A. Jasmine Paolini

B. Aryna Sabalenka

C. Barbora Krejcikova

D. Coco Gauff

Question Type : MCQ
Question ID : 6306801063569
Option 1 ID : 6306804176644
Option 2 ID : 6306804176646
Option 3 ID : 6306804176643
Option 4 ID : 6306804176645

Status : Answered
Chosen Option : C

Marks : 1

Q.19 Who won the bronze medal in the Men’s 50 m rifle 3 positions at Olympic 2024?
Ans A. Swapnil Kusale

B. Amit Panghal

C. Arjun Singh Cheema

D. Anish Bhanwala

Question Type : MCQ
Question ID : 6306801049543
Option 1 ID : 6306804120428
Option 2 ID : 6306804120429
Option 3 ID : 6306804120431
Option 4 ID : 6306804120430

Status : Answered
Chosen Option : A

Marks : 1
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Q.20 Which prestigious award did Gabriella Arrigo receive in 2024?
Ans A. European Space Agency Innovation Award

B. IAF Excellence in International Cooperation Award

C. NASA Distinguished Service Medal

D. UN Space Cooperation Award

Question Type : MCQ
Question ID : 6306801057557
Option 1 ID : 6306804152629
Option 2 ID : 6306804152628
Option 3 ID : 6306804152627
Option 4 ID : 6306804152630

Status : Answered
Chosen Option : B

Marks : 1

Q.21 Match the following temples built between 900 to 1200 A.D. with their respective
locations.

Ans A. a-iii, b-iv, c-i, d-ii

B. a-ii, b-i, c-iv, d-iii

C. a-iii, b-i, c-ii, d-iv

D. a-iv, b-iii, c-ii, d-i

Question Type : MCQ
Question ID : 630680184278
Option 1 ID : 630680714123
Option 2 ID : 630680714122
Option 3 ID : 630680714121
Option 4 ID : 630680714124

Status : Answered
Chosen Option : A

Marks : 1

Section : History of India
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Q.22 In which of the following years was the Simon Commission appointed?
Ans A. 1927

B. 1932

C. 1931

D. 1930

Question Type : MCQ
Question ID : 6306801148033
Option 1 ID : 6306804512232
Option 2 ID : 6306804512233
Option 3 ID : 6306804512231
Option 4 ID : 6306804512230

Status : Answered
Chosen Option : C

Marks : -0.25

Q.23 Who was the founder of the Kushan dynasty?
Ans A. Huvishka

B. Vemo Kadphises

C. Kujula Kadphises

D. Kanishka I

Question Type : MCQ
Question ID : 630680616720
Option 1 ID : 6306802413143
Option 2 ID : 6306802413141
Option 3 ID : 6306802413140
Option 4 ID : 6306802413142

Status : Answered
Chosen Option : D

Marks : -0.25

Q.24 The first evidence of Sati is found in which of the following inscriptions of the Gupta
period?

Ans A. Mandasore

B. Gaya

C. Eran

D. Bhitari

Question Type : MCQ
Question ID : 630680571382
Option 1 ID : 6306802234561
Option 2 ID : 6306802234563
Option 3 ID : 6306802234562
Option 4 ID : 6306802234564

Status : Answered
Chosen Option : A

Marks : -0.25
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Q.25 _______________ made a representation to Captain Leigh for the remission of the
sentence of imprisonment on him and for his installation as Raja of Sambalpur in
October 1857.

Ans A. Jayee Rajguru

B. Surendra Sai

C. Dora Bisoyi

D. Fakir Mohan Senapati

Question Type : MCQ
Question ID : 6306801135500
Option 1 ID : 6306804462151
Option 2 ID : 6306804462152
Option 3 ID : 6306804462150
Option 4 ID : 6306804462153

Status : Answered
Chosen Option : A

Marks : -0.25

Q.26 'Satyartha Prakash' is a work containing the principles of which of the following
organisations?

Ans A. Arya Samaj

B. Prarthana Samaj

C. Brahmo Samaj

D. Satyashodhak Samaj

Question Type : MCQ
Question ID : 630680595382
Option 1 ID : 6306802329720
Option 2 ID : 6306802329722
Option 3 ID : 6306802329721
Option 4 ID : 6306802329723

Status : Answered
Chosen Option : A

Marks : 1

Q.27

Ans A. 1920

B. 1930

C. 1917

D. 1942

Question Type : MCQ
Question ID : 630680577698
Option 1 ID : 6306802259637
Option 2 ID : 6306802259638
Option 3 ID : 6306802259636
Option 4 ID : 6306802259639

Status : Answered
Chosen Option : B

Marks : -0.25
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Q.28 Who among the following was an imperialist guided by the policy of Doctrine of
Lapse?

Ans A. Lord Curzon

B. Lord Lytton

C. Lord Dalhousie

D. Lord Canning

Question Type : MCQ
Question ID : 630680595510
Option 1 ID : 6306802330231
Option 2 ID : 6306802330230
Option 3 ID : 6306802330229
Option 4 ID : 6306802330228

Status : Answered
Chosen Option : A

Marks : -0.25

Q.29 Who among the following was the holder of Iqta?
Ans A. Qazi

B. Kotwal

C. Muqti

D. Amil

Question Type : MCQ
Question ID : 630680572040
Option 1 ID : 6306802237024
Option 2 ID : 6306802237027
Option 3 ID : 6306802237026
Option 4 ID : 6306802237025

Status : Answered
Chosen Option : B

Marks : -0.25

Q.30 Keshav Chandra Sen was associated with which of the following social organisations?
Ans A. Arya Samaj

B. Brahmo Samaj

C. Theosophical Society

D. Dev Samaj

Question Type : MCQ
Question ID : 630680595366
Option 1 ID : 6306802329658
Option 2 ID : 6306802329659
Option 3 ID : 6306802329657
Option 4 ID : 6306802329660

Status : Answered
Chosen Option : B

Marks : 1

Section : Geography
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Q.31

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 6306801064177
Option 1 ID : 6306804179048
Option 2 ID : 6306804179050
Option 3 ID : 6306804179047
Option 4 ID : 6306804179049

Status : Answered
Chosen Option : A

Marks : -0.25

Q.32 Oil and Natural Gas Commission was set up in India in which of the following years?
Ans A. 1989

B. 1991

C. 1956

D. 1945

Question Type : MCQ
Question ID : 630680695590
Option 1 ID : 6306802724599
Option 2 ID : 6306802724600
Option 3 ID : 6306802724602
Option 4 ID : 6306802724601

Status : Answered
Chosen Option : B

Marks : -0.25
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Q.33

Ans
A. 

B. 

C. 

D.

Question Type : MCQ
Question ID : 630680717850
Option 1 ID : 6306802812940
Option 2 ID : 6306802812937
Option 3 ID : 6306802812938
Option 4 ID : 6306802812939

Status : Answered
Chosen Option : C

Marks : -0.25

Q.34 In which year was the PM Gatishakti National Master Plan introduced by the
Government of India?

Ans A. 2024

B. 2023

C. 2022

D. 2021

Question Type : MCQ
Question ID : 630680683411
Option 1 ID : 6306802676368
Option 2 ID : 6306802676367
Option 3 ID : 6306802676366
Option 4 ID : 6306802676365

Status : Answered
Chosen Option : B

Marks : -0.25
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Q.35 In which of the following states are the manganese ore deposits of Bicholim and
Sanguem located?

Ans A. Odisha

B. Gujarat

C. Goa

D. Maharashtra

Question Type : MCQ
Question ID : 630680700384
Option 1 ID : 6306802743516
Option 2 ID : 6306802743513
Option 3 ID : 6306802743515
Option 4 ID : 6306802743514

Status : Answered
Chosen Option : A

Marks : -0.25

Q.36 Which among the following states in India receives the lowest rainfall?
Ans A. Orissa

B. Meghalaya

C. Rajasthan

D. Uttar Pradesh

Question Type : MCQ
Question ID : 630680594065
Option 1 ID : 6306802324509
Option 2 ID : 6306802324508
Option 3 ID : 6306802324511
Option 4 ID : 6306802324510

Status : Answered
Chosen Option : C

Marks : 1

Q.37 The rivers Chambal, Sind, Betwa, and Ken flow in which of the following directions in
the Central Highlands?

Ans A. Northwest to southeast

B. Southeast to northwest

C. Northeast to southwest

D. Southwest to northeast

Question Type : MCQ
Question ID : 630680860191
Option 1 ID : 6306803368704
Option 2 ID : 6306803368701
Option 3 ID : 6306803368702
Option 4 ID : 6306803368703

Status : Answered
Chosen Option : D

Marks : 1
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Q.38 Mediterranean climates are found on the west coasts of continents between
_____________ latitudes.

Ans A. 60° and 70°

B. 80° and 90°

C. 30° and 40°

D. 70° and 80°

Question Type : MCQ
Question ID : 6306801064338
Option 1 ID : 6306804179684
Option 2 ID : 6306804179683
Option 3 ID : 6306804179681
Option 4 ID : 6306804179682

Status : Answered
Chosen Option : A

Marks : -0.25

Q.39 ​Ennore port is a satellite port of which of the following ports of India?
Ans A. Vishakhapatnam

B. Tuticorin

C. Paradwip

D. Chennai

Question Type : MCQ
Question ID : 630680647171
Option 1 ID : 6306802533905
Option 2 ID : 6306802533907
Option 3 ID : 6306802533906
Option 4 ID : 6306802533908

Status : Answered
Chosen Option : A

Marks : -0.25

Q.40 Which of the following is the southernmost point of mainland India?
Ans A. Cape Comorin

B. Cape of Good Hope

C. Cape Leeuwin

D. Cape Horn

Question Type : MCQ
Question ID : 630680871650
Option 1 ID : 6306803413730
Option 2 ID : 6306803413731
Option 3 ID : 6306803413732
Option 4 ID : 6306803413733

Status : Answered
Chosen Option : A

Marks : 1

Section : Indian polity and Economy
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Q.41 When did the RBI commence its operations in India?
Ans A. 1950

B. 1948

C. 1945

D. 1935

Question Type : MCQ
Question ID : 630680650822
Option 1 ID : 6306802548257
Option 2 ID : 6306802548256
Option 3 ID : 6306802548255
Option 4 ID : 6306802548254

Status : Answered
Chosen Option : A

Marks : -0.25

Q.42 From which of the following Constitutions was the concept of Fundamental Duties
taken?

Ans A. British Constitution

B. French Constitution

C. USSR Constitution

D. American Constitution

Question Type : MCQ
Question ID : 630680758863
Option 1 ID : 6306802974418
Option 2 ID : 6306802974420
Option 3 ID : 6306802974419
Option 4 ID : 6306802974417

Status : Answered
Chosen Option : D

Marks : -0.25

Q.43 What percentage of the total expenditure in the Odisha State Budget 2023-24 was
allocated to education?

Ans A. 13.2%

B. 7.6%

C. 14.2%

D. 11.5%

Question Type : MCQ
Question ID : 6306801146953
Option 1 ID : 6306804507949
Option 2 ID : 6306804507947
Option 3 ID : 6306804507950
Option 4 ID : 6306804507948

Status : Answered
Chosen Option : A

Marks : 1
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Q.44 Which part of the Indian Constitution introduced by the 97th Amendment, was declared
unconstitutional by the Supreme Court of India in 2021?

Ans A. Part IX-B

B. Part IX-A

C. Part IX

D. Part X

Question Type : MCQ
Question ID : 6306801044825
Option 1 ID : 6306804101454
Option 2 ID : 6306804101453
Option 3 ID : 6306804101452
Option 4 ID : 6306804101455

Status : Answered
Chosen Option : A

Marks : 1

Q.45

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 630680694347
Option 1 ID : 6306802719666
Option 2 ID : 6306802719667
Option 3 ID : 6306802719664
Option 4 ID : 6306802719665

Status : Answered
Chosen Option : C

Marks : 1
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Q.46

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 630680784806
Option 1 ID : 6306803075503
Option 2 ID : 6306803075502
Option 3 ID : 6306803075504
Option 4 ID : 6306803075505

Status : Answered
Chosen Option : A

Marks : 1

Q.47 Which financial institution of India has been instrumental in promoting microfinance
institutions (MFIs) and self-help groups (SHGs) as vehicles for financial inclusion and
empowerment of women in rural areas?

Ans A. Export-Import Bank of India (EXIM Bank)

B. Small Industries Development Bank of India (SIDBI)

C. National Bank for Agriculture and Rural Development (NABARD)

D. National Housing Bank (NHB)

Question Type : MCQ
Question ID : 630680725440
Option 1 ID : 6306802842874
Option 2 ID : 6306802842873
Option 3 ID : 6306802842872
Option 4 ID : 6306802842875

Status : Answered
Chosen Option : C

Marks : 1

Q.48 Who is the Cabinet Minister for the Ministry of Revenue and Disaster Management in
the Odisha government as of September 2024?

Ans A. Dharmendra Pradhan

B. Suresh Pujari

C. KV Singh Deo

D. Raghunath Mohanty

Question Type : MCQ
Question ID : 6306801126252
Option 1 ID : 6306804425226
Option 2 ID : 6306804425229
Option 3 ID : 6306804425228
Option 4 ID : 6306804425227

Status : Answered
Chosen Option : B

Marks : 1
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Q.49

Ans A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 630680710652
Option 1 ID : 6306802784315
Option 2 ID : 6306802784314
Option 3 ID : 6306802784317
Option 4 ID : 6306802784316

Status : Answered
Chosen Option : B

Marks : -0.25

Q.50 Which Constitutional Amendment removed the Right to Property as a Fundamental
Right?

Ans A. 42nd Amendment

B. 76th Amendment

C. 44th Amendment

D. 24th Amendment

Question Type : MCQ
Question ID : 630680810098
Option 1 ID : 6306803173936
Option 2 ID : 6306803173938
Option 3 ID : 6306803173935
Option 4 ID : 6306803173937

Status : Answered
Chosen Option : C

Marks : 1

Section : Mental ability
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Q.51 This question is based on five, three-digit numbers given below.
(Left) 286 549 317 492 763 (Right)
If 4 is subtracted from each of the given numbers, in how many numbers thus formed
will the second digit be greater than the first digit? NOTE- (Example- 697 – First digit =
6, second digit = 9 and third digit = 7). All operations to be done from left to right.

Ans A. Three

B. Two

C. One

D. None

Question Type : MCQ
Question ID : 630680373939
Option 1 ID : 6306801457028
Option 2 ID : 6306801457029
Option 3 ID : 6306801457027
Option 4 ID : 6306801457030

Status : Not Answered
Chosen Option : --

Marks : 0

Q.52 Steve starts from Point A and drives 3 km towards the West. He then takes a left turn,
drives 2 km, turns left and drives 7 km. He then takes a right turn and drives 5 km. He
then takes a left turn and drive 6 km. He takes a final left turn, drives 7 km and stops at
Point P. How far (shortest distance) and towards which direction should he drive in
order to reach Point A again? (All turns are 90 degrees turns only unless specified)

Ans A. 18 km to the South

B. 11 km to the West

C. 8 km to the East

D. 10 km to the West

Question Type : MCQ
Question ID : 630680750679
Option 1 ID : 6306802942154
Option 2 ID : 6306802942156
Option 3 ID : 6306802942155
Option 4 ID : 6306802942157

Status : Answered
Chosen Option : D

Marks : 1
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Q.53 P, Q, R, X, Y and Z live on six different floors of the same building. The lowermost floor
in the building is numbered 1, the floor above it, number 2 and so on till the topmost
floor is numbered 6. R lives immediately above Y. Only two people live between P and
Y. P lives on an odd numbered floor. X lives immediately below Q. How many people
live between Z and Q?

Ans A. One

B. Four

C. Two

D. Three

Question Type : MCQ
Question ID : 630680935435
Option 1 ID : 6306803666372
Option 2 ID : 6306803666375
Option 3 ID : 6306803666373
Option 4 ID : 6306803666374

Status : Answered
Chosen Option : C

Marks : 1

Q.54 Seven boxes A, B, C, D, E, F and G are kept one over the other but not necessarily in
the same order. Only three boxes are kept below A. Only two boxes are kept between A
and E. Only B is kept immediately above D. F is kept at some place below G and at
some place above C. How many boxes are kept below C?

Ans A. Three

B. One

C. Two

D. Four

Question Type : MCQ
Question ID : 630680903405
Option 1 ID : 6306803539262
Option 2 ID : 6306803539260
Option 3 ID : 6306803539261
Option 4 ID : 6306803539263

Status : Answered
Chosen Option : B

Marks : 1

Q.55 In a certain code language, ‘MEAN’ is coded as ‘2467’ and ‘BINS’ is coded as ‘3715’.
What is the code for ‘N’ in the given code language?

Ans A. 7

B. 1

C. 6

D. 5

Question Type : MCQ
Question ID : 630680959472
Option 1 ID : 6306803761674
Option 2 ID : 6306803761675
Option 3 ID : 6306803761677
Option 4 ID : 6306803761676

Status : Answered
Chosen Option : C

Marks : -0.25
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Q.56 Read the given statements and conclusions carefully. Assuming that the information
given in the statements is true, even if it appears to be at variance with commonly
known facts, decide which of the given conclusion(s) logically follow(s) from the
statements.

Statements:
All cubes are cuboids.
Some cuboids are cones.

Conclusions:
(I) Some cones are cubes.
(II) All cubes are cones.

Ans A. Only conclusion (II) follows.

B. Both conclusions (I) and (II) follow.

C. Only conclusion (I) follows.

D. Neither conclusion (I) nor (II) follows.

Question Type : MCQ
Question ID : 630680917759
Option 1 ID : 6306803596194
Option 2 ID : 6306803596195
Option 3 ID : 6306803596193
Option 4 ID : 6306803596196

Status : Answered
Chosen Option : A

Marks : -0.25

Q.57 G is the only grandson of H. H is the husband of M. Q is the only daughter-in-law of M.
N is K’s brother. Q is married to N. How is G related to K?

Ans A. Son

B. Father

C. Brother’s son

D. Brother

Question Type : MCQ
Question ID : 630680287545
Option 1 ID : 6306801118087
Option 2 ID : 6306801118089
Option 3 ID : 6306801118090
Option 4 ID : 6306801118088

Status : Answered
Chosen Option : B

Marks : -0.25
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Q.58 Refer to the given letter, symbol series and answer the question that follows. Counting
to be done from left to right only.

(Left) @ 3 Ω 9 # & 1 * 2 £ 8 $ % 4 5 & 6 7 (Right)

How many such numbers are there, each of which is immediately preceded by a
number and also immediately followed by a symbol?

Ans A. 0

B. 1

C. 3

D. 2

Question Type : MCQ
Question ID : 630680959419
Option 1 ID : 6306803761462
Option 2 ID : 6306803761463
Option 3 ID : 6306803761465
Option 4 ID : 6306803761464

Status : Answered
Chosen Option : A

Marks : -0.25

Q.59 In a certain code language,

A + B means ‘A is the mother of B’,
A – B means ‘A is the husband of B’,
A x B means ‘A is the wife of B’ and
A ÷ B means ‘ A is the son of B’.

Based on the above, how is P related to T if ‘P x Q ÷ R – S + T’?
Ans A. Brother’s wife

B. Husband’s mother

C. Son’s wife

D. Husband’s sister

Question Type : MCQ
Question ID : 630680732921
Option 1 ID : 6306802872493
Option 2 ID : 6306802872495
Option 3 ID : 6306802872494
Option 4 ID : 6306802872496

Status : Answered
Chosen Option : B

Marks : -0.25
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Q.60 Ajit starts from Point A and drives 5 km towards west. He then takes a right turn,
drives 8 km, turns right and drives 10 km. He then takes a right turn and drives 12 km.
He takes a final right turn, drives 5 km and stops at Point P. How far (shortest distance)
and towards which direction should he drive in order to reach Point A again?

(Note: All turns are 90 degree turns only unless specified.)
Ans A. 4 km to the north

B. 2 km to the west

C. 1 km to the south

D. 3 km to the north

Question Type : MCQ
Question ID : 630680750128
Option 1 ID : 6306802940006
Option 2 ID : 6306802940004
Option 3 ID : 6306802940003
Option 4 ID : 6306802940005

Status : Answered
Chosen Option : B

Marks : -0.25

Q.61 Sakshi walks to her office 15 km away from home. In the morning she covers the
distance in 1 hour whereas, while returning home in the evening, she takes 30 more
minutes to cover the same distance. Find her average speed (in kmph) during the two-
way journey.

Ans A. 12

B. 14

C. 6

D. 8

Question Type : MCQ
Question ID : 630680894215
Option 1 ID : 6306803502877
Option 2 ID : 6306803502880
Option 3 ID : 6306803502878
Option 4 ID : 6306803502879

Status : Answered
Chosen Option : D

Marks : -0.25

Section : Numerical ability test
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Q.62 The list price of a television set is ₹50000. It is sold to a retailer after two successive
discounts of 5% and 12%. The retailer wants to earn a profit of 50% on his cost after
allowing a 20% discount (on its new list price) to the customer. At what price should he
list the television set?

Ans A. ₹78258

B. ₹78515

C. ₹78375

D. ₹78553

Question Type : MCQ
Question ID : 630680995102
Option 1 ID : 6306803904436
Option 2 ID : 6306803904438
Option 3 ID : 6306803904435
Option 4 ID : 6306803904437

Status : Answered
Chosen Option : B

Marks : -0.25

Q.63 Write the expanded form of (3a + 2b + 6c)2.
Ans A. 9a2 + 4b2 + 36c2 + 12ab + 19bc + 36ac

B. 9a2 + 4b2 + 36c2 + 12ab + 24bc + 36ac

C. 9a2 + 4b2 + 36c2 + 12ab + 24bc + 46ac

D. 9a2 + 4b2 + 36c2 + 16ab + 24bc + 36ac

Question Type : MCQ
Question ID : 630680827368
Option 1 ID : 6306803240810
Option 2 ID : 6306803240807
Option 3 ID : 6306803240809
Option 4 ID : 6306803240808

Status : Answered
Chosen Option : C

Marks : -0.25
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Q.64

Find the value of 

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 630680797315
Option 1 ID : 6306803124218
Option 2 ID : 6306803124216
Option 3 ID : 6306803124219
Option 4 ID : 6306803124217

Status : Answered
Chosen Option : C

Marks : -0.25

Q.65 Two pipes can fill a tank in 6 hours and 18 hours, respectively. The time (in hours)
required to fill the tank when both pipes are opened simultaneously is:

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 630680947847
Option 1 ID : 6306803716083
Option 2 ID : 6306803716081
Option 3 ID : 6306803716082
Option 4 ID : 6306803716080

Status : Answered
Chosen Option : B

Marks : -0.25
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Q.66

Ans A. 4094

B. 4092

C. 4079

D. 4096

Question Type : MCQ
Question ID : 630680954854
Option 1 ID : 6306803743627
Option 2 ID : 6306803743626
Option 3 ID : 6306803743625
Option 4 ID : 6306803743624

Status : Answered
Chosen Option : B

Marks : -0.25

Q.67 Manish invested a certain sum of money at 10% per annum simple interest. If he
receives an interest of ₹72405 after 2 years, the sum (in ₹) he invested is:

Ans A. 361850

B. 362174

C. 361144

D. 362025

Question Type : MCQ
Question ID : 630680808924
Option 1 ID : 6306803169278
Option 2 ID : 6306803169276
Option 3 ID : 6306803169277
Option 4 ID : 6306803169275

Status : Answered
Chosen Option : B

Marks : -0.25

Q.68 There are 46 members in group A, 47 members in group B and 12 members in group C.
All the members of these groups went to a restaurant. The average amount spent on
each member of group A, B and C is ₹499, ₹409 and ₹239, respectively. The total
average amount (in ₹) spent per member is:

Ans A. 433

B. 427

C. 429

D. 425

Question Type : MCQ
Question ID : 630680984909
Option 1 ID : 6306803863755
Option 2 ID : 6306803863756
Option 3 ID : 6306803863753
Option 4 ID : 6306803863754

Status : Answered
Chosen Option : A

Marks : -0.25
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Q.69 Find the maximum value of the quadratic expression -x2+16.
Ans A. 25

B. 16

C. −16

D. 12

Question Type : MCQ
Question ID : 630680199690
Option 1 ID : 630680774369
Option 2 ID : 630680774368
Option 3 ID : 630680774367
Option 4 ID : 630680774370

Status : Answered
Chosen Option : B

Marks : 1

Q.70 Kalpana and Sudha got 459 and 720 marks respectively in an examination. If Kalpana
scored 51% marks, then what is the percentage of marks scored by Sudha?

Ans A. 82%

B. 81%

C. 80%

D. 83%

Question Type : MCQ
Question ID : 6306801021549
Option 1 ID : 6306804009247
Option 2 ID : 6306804009246
Option 3 ID : 6306804009244
Option 4 ID : 6306804009245

Status : Answered
Chosen Option : B

Marks : -0.25

Q.71 How do you print a spreadsheet in MS (Microsoft office) Excel?
Ans A. By clicking on the printer icon in the toolbar

B. By pressing Ctrl + P on the keyboard

C. By right-clicking on the spreadsheet and selecting 'Print' from the context menu

D. By selecting 'Print' from the Home menu

Question Type : MCQ
Question ID : 630680792919
Option 1 ID : 6306803107041
Option 2 ID : 6306803107043
Option 3 ID : 6306803107042
Option 4 ID : 6306803107040

Status : Answered
Chosen Option : C

Marks : -0.25

Section : Basic Computer literacy
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Q.72 You are working on a document in MS-Word and want to quickly change the alignment
of a paragraph to be center-aligned using the icons below the menu bar. Which of the
following icons should you click to achieve this?

Ans A. The icon with horizontal lines aligned to the right

B. The icon with horizontal lines justified

C. The icon with horizontal lines aligned to the left

D. The icon with horizontal lines aligned to the center

Question Type : MCQ
Question ID : 630680965792
Option 1 ID : 6306803787669
Option 2 ID : 6306803787670
Option 3 ID : 6306803787667
Option 4 ID : 6306803787668

Status : Answered
Chosen Option : C

Marks : -0.25

Q.73 Which of the following statements best describes the role of application software?
Ans A. Application software is responsible for managing the system's memory and

processing tasks.
B. Application software serves as the interface between the user and the computer

hardware.
C. Application software is used to control the hardware components of a computer.

D. Application software is designed to perform specific tasks such as word processing,
spreadsheet management or graphic design.

Question Type : MCQ
Question ID : 6306801057971
Option 1 ID : 6306804154278
Option 2 ID : 6306804154276
Option 3 ID : 6306804154275
Option 4 ID : 6306804154277

Status : Answered
Chosen Option : D

Marks : 1

Q.74 What is the function of the Start menu in Windows 11 OS?
Ans A. To clean files and applications installed on a computer

B.

To display advertisements

C. To display recently opened files and applications

D. To launch applications and access programs installed on a computer

Question Type : MCQ
Question ID : 630680755117
Option 1 ID : 6306802959649
Option 2 ID : 6306802959647
Option 3 ID : 6306802959648
Option 4 ID : 6306802959650

Status : Answered
Chosen Option : D

Marks : 1
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Q.75 Which of the following notations is valid for reference to a cell in Microsoft Excel by its
column letter and row number?

Ans A. C1R1

B. R1C1

C. A1

D. 1A

Question Type : MCQ
Question ID : 630680915741
Option 1 ID : 6306803588031
Option 2 ID : 6306803588030
Option 3 ID : 6306803588028
Option 4 ID : 6306803588029

Status : Answered
Chosen Option : C

Marks : 1

Q.76 In the field of cryptography, which of the following applications of computers is
essential for ensuring the secure transmission of data over a network, particularly in
the context of quantum computing?

Ans A. Asymmetric Key Encryption based on RSA Algorithm

B. Quantum Key Distribution (QKD) for Secure Communication

C. Hash Functions for Data Integrity Verification

D. Symmetric Key Encryption using Classical Algorithms

Question Type : MCQ
Question ID : 6306801056140
Option 1 ID : 6306804147063
Option 2 ID : 6306804147064
Option 3 ID : 6306804147065
Option 4 ID : 6306804147062

Status : Answered
Chosen Option : C

Marks : -0.25

Q.77 After creating a blank PowerPoint presentation, which of the following steps should
you take to ensure a consistent look and feel throughout the presentation?

Ans A. Immediately start adding text and images to the slides

B. Insert a theme after completing all slides

C. Change the slide layout for each individual slide

D. Apply a slide master before adding any content

Question Type : MCQ
Question ID : 6306801049228
Option 1 ID : 6306804119078
Option 2 ID : 6306804119080
Option 3 ID : 6306804119081
Option 4 ID : 6306804119079

Status : Answered
Chosen Option : D

Marks : 1

10/28/24, 8:16 PM cdn.digialm.com//per/g01/pub/852/touchstone/AssessmentQPHTMLMode1//OSSC241/OSSC241S4D1272/17297515138905997/…

https://cdn.digialm.com//per/g01/pub/852/touchstone/AssessmentQPHTMLMode1//OSSC241/OSSC241S4D1272/17297515138905997/230438902… 74/75

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Q.78 Which of the following steps would you follow to open an existing MS PowerPoint
presentation?

Ans A. Click on 'File' > 'New'

B. Click on 'Insert' > 'New Slide'

C. Click on 'File' > 'Open'

D. Click on 'Home' > 'Open'

Question Type : MCQ
Question ID : 6306801049131
Option 1 ID : 6306804118650
Option 2 ID : 6306804118651
Option 3 ID : 6306804118652
Option 4 ID : 6306804118653

Status : Answered
Chosen Option : C

Marks : 1

Q.79 Which of the following power-saving modes in a Windows OS saves the state of open
documents and applications to the hard disk and then completely powers off the
computer, allowing for zero power consumption until the system is turned back on?

Ans A. Sleep

B. Fast Startup

C. Hibernate

D. Hybrid Sleep

Question Type : MCQ
Question ID : 6306801058343
Option 1 ID : 6306804155743
Option 2 ID : 6306804155746
Option 3 ID : 6306804155744
Option 4 ID : 6306804155745

Status : Answered
Chosen Option : B

Marks : -0.25

Q.80 Which of the following keyboard shortcuts in MS Word is used to check the spelling
and grammar in a document?

Ans A. Ctrl + S

B. Ctrl + G

C. Shift + F12

D. F7

Question Type : MCQ
Question ID : 6306801052495
Option 1 ID : 6306804132364
Option 2 ID : 6306804132366
Option 3 ID : 6306804132367
Option 4 ID : 6306804132365

Status : Answered
Chosen Option : C

Marks : -0.25
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